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ABSTRACT 

 

 

 

A computer- based instrumentation system has been developed for 

temperature measurement. The measurement is using thermocouple type K. 

Thermocouple will detect temperature then send the input to temperature 

transmitter. Temperature transmitter will accept the input from thermocouple 

or dc milivolt input and convert it to a 4 to 20mA signal for transmission. 

Then, the temperature transmitter connected to data acquisition (PCI1710HG) 

that used to read data from the temperature transmitter. SIMULINK model is 

use to interface DAQ with MATLAB. Analog input from DAQ will transfer 

to MATLAB Workspace.  The system is developed with MATLAB 

Graphical User Interface (GUI). GUI will capture data from workspace and 

then calculated average of actual output and output error. The process is 

continued by plotting five point temperature calibrations and error curve. The 

system also can do the evaluation of the uncertainty of temperature 

measurement. Uncertainty of measurement is the doubt that exists about the 

result of any measurement. The system allowed the user to save the plot and 

key in the data in excel. By implementing this system in Industrial 

Instrumentation class, the improvement and continuity of learning process 

will be achieved. 

 

 

 

 

 

 

 

 

 

 

 

 



 

vi 

 

 

 

ABSTRAK 

 

 

Sistem instrumentasi berasaskan sistem komputer telah dibangunkan 

untuk digunakan dalam pengukuran suhu. Pengukuran suhu adalah dengan 

menggunakan thermocouple jenis K. Thermocouple akan mengesan suhu dan 

seterusnya akan menghantar bacaan tersebut kepada pemancar suhu. 

Pemancar suhu akan akan menerima bacaan yang dihantar daripada 

thermocouple dan seterusnya menukar input yang diterima ke dalam bentuk 

arus iaitu  4 – 20 mA bagi memudahkan penghantaran data.kemudian, 

kesemua alat-alat yang digunaka dalam pengukuran suhu akan disambungkan 

dengan PCI1710HG iaitu  satu alat yang digunakan untuk menerima data dan 

membaca data daripada alat pengukuran suhu. Model SIMULINK digunakan 

untuk menghubugkan PCI1710HG dengan MATLAB. Seterusnya, input 

analog akan dihantar ke MATLAB workspace. Sistem ini telah dibangunkan 

dengan menggunakan MATLAB Graphical User Interface (GUI). GUI akan 

menyalin data dari WORKSPACE kemudian data tersebut akan digunakan 

bagi pengiraan  purata untuk bacaan sebenar dan peratusan ralat. Proses 

seterusnya adalah  melakar graf untuk  graf lima titik pengujian alat 

pengukuran suhu dan graf untuk lengkungan  ralat bacaan. System ini juga 

turut memuatkan atau digunakan untuk evaluasi untuk ketidakpastian bacaan 

bagi pengukuran suhu. Sistem ini turut membolehkan pengguna menyimpan 

graf yang sudah dilakar dan kemudian  memasukkan kesemua bacaan dan 

pengiraan ke dalam EXCEL. Ringkasnya pengunaan system ini dalam 

pembelajaran bagi matapelajaran Industrial Instrumentation akan 

menyebabkan  peningkatan dan kelancaran dalam process pembelajaran dapat 

dicapai. 
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CHAPTER 1 

 

 

 

 

INTRODUCTION 

 

 

 

 

1.1 Project Overview 

 

Computer-based measurement systems are used in a wide variety of 

applications. Computer-based instrumentation for temperature is measure 

system that place the instrument’s intelligence and measurement circuitry of 

temperature inside the computer. Instrument that use are digital thermometer 

7563, ISOTECH Jupiter 650B,Yokogawa Temperature Transmitter 

(PT100),HART 375 Field Communicator and two thermocouples type k ( one 

thermocouple as a reference and other one as a measured value ).  

Generally, thermocouple is a sensor for measuring temperature. 

Thermocouple operation is based on the physical principles that if two 

dissimilar metal wires are joined together and the point of joining is heated 

(or cooled), a voltage difference appears across the two unheated end. Type K 

thermocouples are made up of a positive Chromel wire and a negative 

Alumel wire. They are the most popular thermocouple type and offer a wide 

measurement range with good temperature precision.  Thermocouple type k can 

read temperature in range -200 °C to +1200°C and develops approximately 0.04 

mV/°C. 
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Data acquisition (DAQ) is the sampling of the real world to generate data 

that can be manipulated by a computer. In order to take measurements with 

computer-based DAQ hardware, temperature transmitter, signal conditioning 

equipment and software such as MATLAB is needed. DAQ typically involves 

acquisition of signals and waveforms and processing the signal to obtain desired 

information. In this project, PCI 1710HG will be use. The PCI-1710 Series are 

multifunction cards for the PCI bus. Their advanced circuit design provides 

higher quality and more functions, including the five most desired 

measurement and control functions: 12-bit A/D conversion, D/A conversion, 

digital input, digital output, and counter/timer [1]. 

 

MATLAB GUI   is a high-level language and interactive environment 

that enables you to perform computationally intensive tasks faster than with 

traditional programming languages such as C, C++, and FORTRAN. 

MATLAB is a numerical computing environment and programming 

language. Created by Te Math Work, MATLAB allows, plotting of function 

and data, implementation of algorithms, creation of user interfaces, and 

interfacing with programs in other languages [2].  

 

1.2 Problem Statement 

 

The problem statement is to do the improvement or continuity of learning 

process. Before this student only do the experiment at lab and then insert the data 

and draw the graph manually. This will cause inaccurate results. So to solve this 

problem, we need to create a system using MATLAB which will produce high 

accuracy result. This system can use data for uncertainty evolution and plot five 

point temperature calibrations. It also uses to compare and measure temperature 

value and actual value and automatically calculate the output error and graphing for 

output error curve. So that, in future this system can be use for learning process. 
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1.3 Objectives 

 

This project has three objectives. The first objective is to understand 

the basic measurement principles of temperature transmitter using 

thermocouple type k. This is very important to make more understand the 

basic of temperature measurement so that the project can do smoothly. 

 

Second objective is to develop a hardware that can use to integrate 

signal from instrument to software. DAQ model PCI1710HG Advantech is 

used in this project. The basic operation of DAQ card is also need to be 

studied. 

 

The third objective is to develop the system using MATLAB GUI for 

student to use in the future. The application software such as MATLAB GUI 

is the brain of DAQ system. The application of MATLAB GUI controls the 

DAQ hardware for acquiring data. Once the data is acquired, the MATLAB 

GUI can use to analyze and present the data. 

 

1.4 Scopes 

 

There are several scopes that need to be proposing in this project. First 

scope is to do the basic temperature measurement such as five point 

calibration of temperature transmitter. Calibrations are the process of 

determining the relation between the output of measuring instrument and the 

value of the input quantity or attribute a measurement standard. 

 

The second scope is to integrate the signal from instrument to 

software, so the hardware is needed to be developed. Hardware that will be 

use is DAQ card which is a basic A/D converter coupled with an interface 

that allows a personal computer to control the actions of the A/D, as well as 

to capture the digital output information from the converter. A DAQ card is 

designed to plug directly into a personal computer's bus.  
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All the power required for the A/D converter and associated interface 

components is obtained directly from the PC bus. 

 

Then the third scope is to create a program using MATLAB that can 

interface with the hardware component. The PC will read the data 

(temperature reading) from the Thermocouple reading using real time 

application. Then, the program that creates using MATLAB will do the 

evaluation of uncertainty of the measurement. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

CHAPTER 2 

 

 

 

 

LITERATURE REVIEW 

 

 

 

 

2.1 Introduction 

 

The literature on fundamentals and applications of data acquisition, 

instrumentation, and control to engineering and technology is very extensive. 

Today in any type of computer aided manufacturing project work and 

laboratory tests, precision and reliability of instrumentation and data 

acquisition techniques may cause major impacts on results and outcomes. 

Therefore, students in technology programs must gain knowledge and skills 

pertinent to their curriculum and job requirements when they need to obtain 

any type of physical or virtual data on manufacturing, testing, measurement, 

and protection areas [1].  

 

2.2 MATLAB GUI Based Instrumentation System 

 

At the simplest level, data acquisition can be accomplished manually 

using paper and pencil, recording readings from a multimeter or any other 

instrument. For some applications this form of data acquisition may be 

adequate. However, data recording applications that require large number of 

data readings where very frequent recordings are necessary must include 

instruments or microcontrollers to acquire and record data precisely [2].  
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After more than 20 years of development, MATLAB has evolved 

from a powerful matrix calculation application into a universal programming 

tool used extensively within scientific and engineering communities both 

commercial and academic. MATLAB versions 6.0 and 7.0 include 

functionality for developing advanced graphical user interfaces, GUIs, and 

real-time animation and graphics. GUI applications offer many advantages 

for users who wish to solve complex problems by providing interactivity and 

visual feedback. GUI development can apply in instrumentation and data 

Acquisition interfaces [3]. 

 

2.3 Graphical User Interface 

The graphical user interface (GUI) is intended to give a view of the 

status of the data acquisition system and its sub-systems (e.g. Event Transfer, 

Event filter, Event builder, Back End, etc.) and to allow the user to control its 

operation. The GUI was developed not only for general users, such as shift 

operators, but also to provide DAQ experts the ability to control and debug 

the DAQ system. The run control system can have many GUIs associated 

with a particular experiment. However, only one GUI can be a master, 

capable of controlling the DAQ system. The rest of the GUIs will visualize 

the monitored information. In the run control environment the GUI is 

considered to be a software component and will have an associated agent in 

the platform to interact with the DAQ/control component agents [4]. 

 

2.4 Temperature calibration and measurement 

 

2.41 Fundamental of Temperature Calibration 

 

Temperature is one of the most frequently measured parameters in 

industrial processes. Wide varieties of mechanical and electrical 

thermometers are used to sense and control process temperatures. Regular 

calibration of these thermometers is critical to ensuring consistent quality of  
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product manufactured, as well as providing regulatory compliance for some 

industries [5]. 

 

Most simply stated, temperature calibration consists of placing a 

thermometer under test into a known, stable temperature environment. A 

comparison is made between the actual temperature and the reading indicated 

by the thermometer under test and the difference is noted. 

 

Adjustments can then be made either directly to the thermometer or to 

its readout. Electrical thermometers are adjusted by mathematically re-

creating the coefficients used by SMART transmitters or other readout 

devices to translate their electrical output to temperature.  

 

In industrial applications, the temperature environment is usually 

provided by a drywell, or "dry-block" calibrator, or a micro-bath. Both offer 

portability and a wide range of temperatures. Drywells use high stability 

metal blocks with drilled wells to accept the reference and UUT. Drywells 

typically cover ranges from -45°C to 1200°C and micro-baths cover ranges 

from -25°C to 200°C. Micro-baths are similar in size to drywells but use a 

small tank of stirred fluid instead of a metal block. Micro-baths offer 

significant advantages when calibrating short or odd shaped probes. 

 

2.42 External and Internal Reference 

 

Micro-baths and dry-wells have a built-in sensor to provide a 

feedback loop to the unit's controller and to provide a temperature reading to 

the user. The manufacturer of the heat source can calibrate this sensor so the 

unit displays a traceable temperature within a stated uncertainty. 

 

The reference system, however, should be more accurate than the 

process system being calibrated. As a general rule, temperature uncertainties 

are larger at higher temperature. Using an internal reference is sometimes  
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preferred because it requires fewer instruments and enhances portability for 

field applications. This block diagram is illustrated in Figure 2.1. 

 

Figure 2.1: Heat source as reference standard 

Uncertainty requirements are more rigorous, external references 

thermometers help improve system uncertainty (see Figure 2.2). Because 

external thermometers are more accurate, they increase the relative 

significance of other components of calibrations uncertainty, such as 

uniformity and stability. It is, of course, critical in any calibration to account 

for all sources of uncertainty in the process.  

 

Figure 2.2: External preference standard 
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2.43 Component Calibrations 

Most temperature sensors used in processes are read by transmitters, 

which send a 4 to 20 mA signal to a control panel, which then displays the 

temperature for process monitoring. Several calibration methodologies are 

used in the process plant and the most representative method being to 

calibrate the complete measurement system from sensor through transmitter 

to indicator or controller; alternatively each component of the measurement 

system can be individually calibrated.  

The temperature sensor can be individually calibrated using a drywell 

or micro-bath heat source to simulate the process temperature. If the 

temperature sensor is electrical, a readout device measures its output.  

The transmitter is calibrated using a precision simulator to generate 

the resistance or voltage output from the temperature sensor and input to the 

transmitter. The simulator also measures the resulting transmitter current or 

voltage output. The transmitter is adjusted to ensure that the output follows 

the input, e.g. for a 4 to 20 mA transmitter with a range of 50°C to 200°C, 4 

mA corresponds to 50°C and 20 mA corresponds to 200°C. The simulator 

provides a wide range of input and output ranges to cover all resistance 

thermometer and thermocouple types.  

The indicator or controller is also calibrated using a precision 

simulator to generate simulate the resistance or current input from the 

transmitter. The indicator or controller is adjusted so that the display variable 

matches the simulated input.   
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2.5 Software  Interfacing 

 

Data acquisition is the sampling of the real world to generate data that 

can be manipulated by a computer. Sometimes abbreviated DAQ or DAS, 

data acquisition typically involves acquisition of signals and waveforms and 

processing the signals to obtain desired information. The components of data 

acquisition systems include appropriate sensors that convert any 

measurement parameter to an electrical signal, which is acquired by data 

acquisition hardware. 

 

Acquired data is displayed, analyzed, and stored on a computer, either 

using vendor supplied software, or custom displays and control can be 

developed using various text-based programming languages such as BASIC, 

C, Fortran, Java, Lisp, Pascal. It is a standard programming method to access 

data acquisition hardware.  MATLAB provides a programming language but 

also built-in graphical tools and libraries for data acquisition and analysis.  

 

2.51 Data Acquisition 

Data acquisition begins with the physical phenomenon or physical 

property of an object (under investigation) to be measured. This physical 

property or phenomenon could be the temperature or temperature change of a 

room, the intensity or intensity change of a light source, the pressure inside a 

chamber, the force applied to an object, or many other things. An effective 

data acquisition system can measure all of these different properties or 

phenomena. 

 A transducer is a device that converts a physical property or 

phenomenon into a corresponding measurable electrical signal, such as 

voltage or current. The ability of a data acquisition system to measure 

different phenomena depends on the transducers to convert the physical 

phenomena into signals measurable by the data acquisition hardware.  

http://www.answers.com/topic/programming-language
http://www.answers.com/topic/basic-simple-programming-language
http://www.answers.com/topic/c-programming-language
http://www.answers.com/topic/fortran
http://www.answers.com/topic/java-programming-language
http://www.answers.com/topic/lisp
http://www.answers.com/topic/pascal-programming-language-1
http://www.answers.com/topic/matlab
http://www.answers.com/topic/phenomenon
http://www.answers.com/topic/physical-property-2
http://www.answers.com/topic/physical-property-2
http://www.answers.com/topic/transducer
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2.52 DAQ Hardware 

DAQ hardware is what usually interfaces between the signal and a 

PC. It could be in the form of modules that can be connected to the 

computer's ports (parallel, serial, USB, etc...) or cards connected to slots 

(PCI, ISA) in the mother board. Usually the space on the back of a PCI card 

is too small for all the connections needed, so an external breakout box is 

required. The cable between this Box and the PC is expensive due to the 

many wires and the required shielding and because it is exotic. DAQ-cards 

often contain multiple components (multiplexer, ADC, DAC, TTL-IO, high 

speed timers, RAM).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.answers.com/topic/parallel-port
http://www.answers.com/topic/serial-port
http://www.answers.com/topic/universal-serial-bus
http://www.answers.com/topic/motherboard


 

 

 

 

 

 

 

CHAPTER 3 

 

 

 

 

HARDWARE DESIGN 

 

 

 

 

3.1 Instrument  

 

The process of create computer-based instrumentation for temperature 

can be divided in to three main parts. There are instruments, hardware and 

software. The instruments are digital thermometer 7563, ISOTECH Jupiter 

650B, Yokogawa Temperature Transmitter (PT100), Yokogawa digital 

manometer MT 220, HART 375 Field Communicator and two thermocouples 

type k (one thermocouple as a reference and other one as a measured value).  

 

3.1.1 Digital Thermometer 7563 

 

 The 7563 Digital Thermometer has 16 ranges of temperature sensors 

and DC, V, and Ohm measuring functions. Yokogawa-original A/D converter 

(feedback pulse width modulation method) features superior noise immunity, 

stability and high-speed sampling. In addition, versatile functions are suitable 

for system use and cover a wide variety of applications from test to R&D. 

Figure 3.1 shows the digital thermometer 7563. 
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Figure 3.1: Digital Thermometer 7563 

 

3.1.2 ISOTECH Jupiter 650B 

 

The Isotech Jupiter 650 B offers industry-leading performance in an 

easy-to-use portable package. With its wide temperature range, the Isotech 

Jupiter 650 dry block calibrator will reach that important 1200°F mark 

making it ideal for the calibration of thermocouples as well as platinum 

resistance thermometers. The Isotech Jupiter 650 dry block calibrator has 

been designed for fast heating and cooling for convenient field use. For 

flexibility, surface sensor and infrared thermometer accessories can be added.  

 Linear Process Inputs including 4-20mA current transmitters to be 

displayed on the built-in indicator. The Isotech Jupiter 650 dry block 

calibrator's SITE indicator is commonly used to display an external standard 

thermometer giving greater accuracy by eliminating temperature gradient and 

loading errors. Figure 3.2 shows the ISOTECH Jupiter 650B. 

 

Figure 3.2: ISOTECH Jupiter 650B 
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3.1.3 Yokogawa Temperature Transmitter (PT100) 

 

Temperature Transmitter use to convert thermocouple input to analog 

signals for direct interface with computer- based system.  Temperature 

transmitter will accept the input from thermocouple and convert it to a 4 to 

20mA signal for transmission.  Signal from the thermocouple are very weak 

and can be easily affected by RFI and EMI interferences. These transmitters 

are robust and immune to RFI and EMI interferences. It also allows upscale 

and downscale temperature setting. User can set error correction and sensor 

failure detection if desire with ease. Figure 3.3 shows the Yokogawa 

Temperature Transmitter (PT100). 

 

Figure 3.3: Yokogawa Temperature Transmitter (PT100) 

 

3.1.4 Yokogawa digital manometer MT 220 

 

The MT220 can measure temperature with outstanding accuracy, high 

resolution and excellent stability. It offers a wealth of functions for field 

calibration, including transmitter output measurement (DCV/DCA functions), 

24-V DC output, percent error readout, measurement data memory, and Ni-

Cd battery operation. Figure 3.4 shows the Yokogawa digital manometer 

MT220. 

 

Figure 3.4: Yokogawa digital manometer MT 220 
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3.1.5 HART 375 Field Communicator 

 

 375 Field Communicator is the new standard in handheld 

communicators. It was universal HART® and Foundation TM field bus, 

intrinsically safe, rugged and reliable. Figure 3.5 shows HART 375 Field 

Communicator. 

- 

 

Figure 3.5: HART 375 Field Communicator 

 

3.1.6 2793 Decade Resistance Box 

 

            Model 2793 is high-accuracy, stable DC variable resistor with 6 

dials and is available in two styles: 279301 for medium resistance from 0.1 

to 1,111.210 Ω in 1 mΩ steps (best suited for calibration of resistance 

thermometers or bridges); 279303 for high resistance from 0 to 111.1110 

MΩ in 100 Ω steps (suitable for calibration of insulation resistance testers 

or bridges).Figure 3.6 shows 2793 Decade Resistance Box. 

 

 
 

Figure 3.6: 2793 Decade Resistance Box 

 



 

3.2 Thermocouple Type K 

 

Thermocouple is a temperature sensor that measure temperature by 

generating a small voltage signal proportional to the temperature difference 

between the junctions of two dissimilar metals. One junction (the hot 

junction) is typically encased in a sensor probe at the point of measurement; 

the other junction (the cold junction) is connected to the measuring 

instrument. The measurement instrument measures the voltage signal and the 

cold junction temperature then computes the temperature. 

Type K is made from Chromel (Nickel-Chromium Alloy) for positive 

lead and   Alumel (Nickel-Aluminium Alloy) for negative lead. This is the 

most commonly used "general purpose" thermocouples. They are available in 

the ~ -200 °C to +1200 °C range. Thermocouple type K shows by Figure 3.7. 

 

Figure 3.7: Thermocouple Type K 

3.3 Data Acquisition 

 

Data acquisition cards are those cards that are used as interfaces 

between an instrument and a computer in order to capture data for 

temperature instrumentation. The 1710HG features 16 channels of analog 

input, two channels of analog output, a 68-pin connector and eight lines of 

digital I/O.  
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The PCI-1710 Series are multifunction cards for the PCI bus. Their 

advanced circuit design provides higher quality and more functions, including 

the five most desired measurement and control functions: 12-bit A/D 

conversion, D/A conversion, digital input, digital output, and counter/timer. 

Figure 3.8 shows PCI-1710HG. 

 

 

 

Figure 3.8: PCI-1710 HG 

 

3.4  Equipment Connection 

 

24V power supply is connected to 4-20mA ammeter with series 

connection. Then negative side of power supply is connected to 2793 decade 

resistance box (250 ohm). Ammeter also connected to positive temperature 

transmitter while 2793 decade resistance box is connected to negative 

temperature transmitter. Next, HART 375 field communicator is connected 

parallel with temperature transmitter. 

 

Meanwhile, Thermocouple type K is connected to temperature 

transmitter where positive thermocouple (red wire) is connected to pin 

number 2 of temperature transmitter, while white wire (-) of thermocouple is 

connected to pin number 1. The other one of thermocouple is functioned as 

reference. It connected to pin number 6 (for positive wire) and pin 5(for 

negative wire). 
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Temperature will detected by thermocouple and then thermocouple 

will send the input to temperature transmitter. The input from thermocouple 

will accepted by temperature transmitter and converted to a 4 to 20mA signal 

for transmission. 

 

Then, the instrument is connected with the data acquisition (DAQ). 

DAQ that used in this project is PIC1710 HG which is the sampling of the 

real world to generate data that can be manipulated by a computer. The 

connection is show in figure 3.9. 

 

 

 

Figure 3.9: Equipment Connection 
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3.5 Block Diagram of the System 

 

Refer to figure 3.10; DAQ (PCI1710HG) is used to interface the 

instrument with the system that has developed using MATLAB. SIMULINK 

model is used to run the DAQ and then data from instrument was transferred 

to MATLAB WORKSPACE. Data that transferred into workspace is 

captured and displayed at MATLAB GUI. Data that captures is used for 

calculation of average of actual output and output error. Meanwhile graph for 

five point calibration of temperature transmitter and output error versus MSU 

applied value are plotted and saved. Afterward, the data also used for 

uncertainty evaluation. 

 

 

 

 

Figure 3.10: Block diagram of the system 
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3.6 Experiment procedures 

 

 Figure 3.11 shows the procedures of temperature instrumentation; 

 

  

 

                                                                  

 

Figure 3.11: Flow diagram of experiment procedures 
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Connect the equipment as shown in figure 1 

Adjust the MSU such as that UUT reads the 

first point. In the case of the temperature 

transmitter the first point on the output is 4 

mA which corresponds to an input of 0° C. 

Set the required value of the MSU as in table 

1. 
Then check the next point, that is 25C C and 

adjust the MSU so that the UUT gives this 

reading. Similarly proceeds till the maximum 

value of the fifth point that is 100°C is 

reached. 

Calibrate the temperature transmitter using 

the HART 375 Field Communicator. 

Plot the five point calibration output curve 

for the EJX110A temperature transmitter 

against the MSU applied value. Then plot the 

output error curve for the EJX110A 

temperature transmitter against the MSU 

applied value and comment the curves. 

START 

   END 



 

3.7 DAQ Configuration 

 

3.7.1 Real Time Window Target Setup 

 

 Real time window Target enables to run Simulink and Stateflow 

models in real time on desktop or laptop PC for rapid prototyping or 

hardware-in-the-loop simulation of control system and signal processing 

algorithms. A real-time execution can be created and controlled entirely 

through Simulink. Using Real-Time Workshop, C code can be generated, 

compiled, and started real-time execution on Windows PC while interfacing 

to real hardware using PC I/O board (PCI-1710HG). I/O device drivers are 

included to support an extensive selection of I/O boards, enabling to interface 

to sensors, actuators, and other devices for experimentation, development, 

and testing real-time systems. Simulink block diagram can be edited and 

Real-Time Workshop can be used to create a new real-time binary file. This 

integrated environment would implement any designs quickly without 

lengthy hand coding and debugging. Figure 3.12 shows the required product 

of Real Time Window Target. 

 

Figure 3.12: Required Products of Real Time Window Target 
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REAL TIME WINDOW 

TARGET 

REAL_TIME 

WORKSHOP 

Convert simulink 

blocks and code from 

stateflow Coder into C 

code 

SIMULINK 

Environment to model 

physical systems and 

controller using block 

diagrams 

MATLAB 

Command-line interface for the 

Real-Time Window Target 



 

Real –Time Window Target includes a set of I/O blocks that provide 

connection between the physical I/O board and real –time model. Hardware –

in-the-loop simulations can be ran quickly observed how simulink model 

responds to real-world behavior. I/O signals can be connected using the block 

library for operation with numerous I/O boards. 

 

The following types of blocks are included: 

 

 Digital input blocks: connect digital input signal to simulink block 

diagram to provide logical inputs. 

 Digital output blocks: connect logical signals from Simulink block 

diagram to control external hardware. 

 Analog input blocks: enable to use A/D converters that digitalize 

analog signals for us as inputs to simulinks block diagrams. 

 Analog output blocks: enable simulinks block diagram to use D/A 

converters to output analog signals from simulink model using I/O board(s). 

 Counter Input Blocks: enable to count pulses or measure frequency 

using hardware counters on I/O board(s). 

 Encoder Input blocks. Enable to include feedback from optical 

encoders. 

 

3.7.2 Installation and Configuration 

 

 The Real-Time Window Target is a self- targeting system where the 

host and the targeting computer are the same computer. It can be installed on 

a PC-compatible computer running Window NT 4.0, Windows 2000, or 

Windows XP. 
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3.7.2.1 C Compiler 

 

 The Real-Time Windows Target requires one of the following C 

compilers which are not included in with the Real-Time Windows Target: 

 Microsoft Visual C/C++ compiler- Version 5.0, 6.0, 7.0. 

 Watcom C/C++ compiler- version 10.6, and 11.0. During installation 

of watcom C/C++ compiler, a DOS target is specified in addition to windows 

target to have the necessary libraries available for linking. 

 

After installation, the MEX utility is run to select compiler as the default 

compiler for building real-time applications. 

 

Real-Time Workshop uses the default C compiler to generate 

executable code, and the MEX utility uses this compiler to create MEX-files. 

This procedure is executed in order to select either a Microsoft Visual C/C++ 

compiler before build an application. Note, the LCC compiler is not 

supported: 

 

1. mex- setup is typed in the MATLAB window 

MATLAB will display the following message: 

Please choose your compiler for building external interface 

(MEX) files. Would you like mex to locate installed compilers? ([y]/n): 

Then a letter “y” is typed 

 

MATLAB will display the following message: 

   Select compiler: 

  [1]: WATCOM compiler in c:\watcom 

  [2]: Microsoft compiler in c:\visual  

  [0]: None 

  Compiler: 

Next, a number is typed. For example, number 2 is typed to select the 

Microsoft compiler. 
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MATLAB will display the following message: 

 Please verify your choices: 

 Compiler: Microsoft 5.0 

 Location: c:\visual 

 Are these correct? ([y]/n) 

Finally, a letter “y” is typed 

MATLAB will reset the default compiler and display the message: 

 The default options file: 

 “c:\WINNT\Profiles\username\Application 

Data\MathWorks\MATLAB\mexopts.bat” is being updated. 

 

3.7.2.2 Installing the kernel 

 

 During installation, all software for the Real-Time Window target is 

copied onto hard drive. The kernel is not automatically installed. Installing 

the kernel sets up the kernel to start running in the background each time 

when computer is started. The kernel can be installed just after the Real-Time 

Windows Target has been installed. The installation of the kernel is necessary 

before a Real-Time Windows Target can be executed: 

1. rtwintgt-install is typed in the MATLAB window. 

MATLAB will display the following message 

You are going to install the Real-Time Windows 

Target kernel. 

  Do you want to proceed? [y]: 

 

2. The kernel installation is continued by typing a letter “y”. 

MATLAB will install the kernel and display the following message 

The Real-Time Windows Target kernel has been 

successfully installed. 

The computer has to be restart if a “restart” message being displayed. 

 

3. The kernel should be checked whether it was correctly installed. Then, 

rtwho is typed. 
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MATLAB would display a message similar to 

Real-Time Windows Target version 2.5.0 (c) The 

Mathworks, inc.1994-2003 

MATLAB performance = 100.0% 

Kernel timeslice period = 1ms 

 

After the kernel being installed, it remains idle, which allows 

windows to control the execution of any standard Windows application. 

Standard Windows applications include internet browsers, word processors, 

MATLAB, and so on. It only during real-time execution of model that the 

kernel intervenes to ensure that the model is given priority to use the CPU to 

execute each model updating at the prescribed sample intervals. Once the 

model update at a particular sample interval completed, the kernel releases 

the CPU to run any other Windows application might need servicing. 

 

 

3.7.2.3 Testing the installation 

 

 The installation can be tested by running the model rtvdp.mdl. This 

model does not have any I/O blocks, so that this model can be run regardless 

of the I/O boards in computer. Running this model would test the installation 

by executing Real-Time Workshop, the Real –Time Window Target, and the 

Real-Time Windows Target kernel. After the Real-Time Windows Target 

kernel being installed, the entire installation can be tested by building and 

running a Real-Time application. The Real-Time Window Target includes the 

model rtvdp.mdl, which already has the correct Real-Time Workshop options 

selected for users: 

 

1. rtvdp is typed in the MATLAB window 

The simulink model rtvdp.mdl window will be opened as shown in Figure 

3.13. 
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Figure 3.13: Simulink Model rtvdp.mdl 

 

2. From the Tools menu, it should be pointed to Real-Time Workshop 

and then clicked Build Model. The MATLAB window display the following 

messages: 

 

# # # starting Real-Time Workshop build for model: rtvdp 

# # # Invoking Target Language Compiler on rtvdp.rtw 

. . . 

# # # Compiling rtvdp.c 

. . . 

# # # Create Real-Time Windows Target module rtvdp.rwd. 

# # # Successful completion of Real-Time Workshop build 

procedure for model:rtvdp 

 

3.  From the Simulation menu, External should be clicked and followed 

by   clicking Connect to target. 

The MATLAB window displayed the following message: 

Model rtvdp loaded 
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4. Start Real-Time Code is clicked from Simulation menu. 

The scope window will display the output signals. After the Real-

Time application has been run, Scope Window should indicate such a 

figure as shown in figure 3.23. 

 

 

Figure 3.14: Output Signals of rtvdp.mdl 

 

5.  From the Simulation menu, after the Stop Real time Code is clicked, 

the real-time application will stop running and then the Scope window will 

stop displaying the output signals. 

 

 

3.7.3 Procedures of Creating Real Time Applications 

 

3.7.3.1 Creating a Simulink Model 

 

This procedure explains how to create a simple Simulink model. This 

model is used as an example to learn other procedures in the Real-Time 

windows Target. A Simulink model has to be created before it can be run as 

simulation or create a real-time application: 
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1. Simulink is typed in the MATLAB Command Window. 

The simulink Library browser window is opened as shown in Figure 3.13. 

   

2. From the toolbar, the Create a new model button is clicked. 

 

 

 

Figure 3.15: create a new model 

 

An empty Simulink window is opened. With the toolbar and status bar 

disabled, the window looks like the following figure (Figure 3.16). 

 

 

 

Figure 3.16: Empty simulink model 
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3. In the simulink Library Browser window, Simulink is double-clicked, 

and then Sources is also double clicked. Next, signal Genarator is clicked and 

dragged to the Simulink window. 

Sinks is clicked. Scope is clicked and dragged to the Simulink window. Real-

Time window Target is clicked. Analog input is clicked and dragged to the 

Simulink window. 

   

4. The Signal Generator output is connected to the scope input by 

clicking-and –dragging a line between the blocks. Likewise, the Analog 

Input input is connected to the connection between Scope and Signal 

Generator. 

 

5. The Signal Generator block is double clicked. The Block Parameters 

dialog box opens. From the Wave form list, square is selected. 

In the Amplitude text box , 0.25 is entered. 

In the frequency text box. 2.5 are entered. 

From the Units list, hertz is selected. 

The Block Parameters dialog box is shown in the Figure 3.17. 

 

 

Figure 3.17: Block Parameters of Signal Generator 
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6. OK is clicked. 

7. The analog input block is double clicked  

The Block Parameters dialog box will open 

8.  The Install new baoard button is clicked a board name. 

For    example, it should be pointed to Advantech and then clicked 

PCL1710HG. 

9. one of the following is selected: 

 For an ISA bus board, a base address is entered. This value must 

match the base address switches or jumpers set on the physical board. 

For example, to enter a base address of 0x300 in the address box, 300 

is typed. The base address also could be selected by selecting check 

boxes A9 through A3. 

 For a PCI bus board, the PCI slot is entered or the Auto-detect check 

box is selected. 

 

10. The Test button is clicked. 

The Real-Time window Target tries to connect to the selected board 

and the following message would display if successful. It can be seen 

in Figure 3.18. 

 

 

Figure 3.18: Board Test OK 

 

11. On the message box, OK is clicked. 

12. The same value as entered in the Fixed step size box from the  

Configuration Parameters dialog box is entered in the Sample time 

box. For example, 0.001 is entered. 
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13. A channel vector that select the analog input channels that are using on 

this board is entered in the output Channels box. the vector can be 

any valid MATLAB vector form. For example, to select analog output 

channel on PCI1710HG board. 

 

14. The input range for all the analog input channels that have been 

entered in the input channels box is chosen from the Output range 

list. For example, with the PCI1710HG, 0 to 5 V is chosen. 

 

15. From the block input signal list, the following options is chosen: 

 Volt - expects a value equal to the analog output voltage. 

 

 Normalized unipolar – expects a value between 0 to +1 that is 

converted to the full range of the output voltage regardless of the 

output range. For example, an analog output range of 0 to +5 volts and 

-5 volt would both be converted from values between 0 to +1. 

 

 Normalized bipolar - expects a value between -1 and +1 that is 

converted to the full range of the output voltage regardless of the 

output voltage range. 

 

 Raw – Expects a value of 0 to 2n-1. For example, a bit A/D converter 

would expect a value between 0 to 212-1(0 to 4095). 

 

 The advantage of this method is expected value is always an integer 

with no round errors. 

 

16. The initial value is entered for each analog output channel that has 

been entered in the Output channels box. For example, if 1 is entered 

in the Output Channels Box, and an initial value of 0 volts is needed, 

0 in entered. 
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17. The final value is entered for each analog channel that has been 

entered in the Output channels box. For example, if 1 is entered in the 

Output Channels box, and a final value is needed, 0 is entered. The dialog 

box would look similar to the figure 3.19 if Volts is chosen. 

 

 

 

Figure 3.19: Block Parameters of Analog Output 

 

18. One of the following is executed: 

 Apply is clicked to apply the changes to the model and the dialog box 

is left open 

 OK is clicked to apply the changes to the model and the Block 

Parameters: Analog Output dialog box will close. 

 

19. Parameters dialog box is closed, and the parameter values are saved 

with   the Simulink model. 

 

20. In the Simulink window, the Scope block is double clicked. 

 A Scope window will open 

 

                                                                                                                         33 

 



 

21. The Parameters button is clicked. 

A Scope parameters dialog box will open 

 

22. The General tab is clicked. The number of graphs that is needed in 

one Scope window is entered in the Number of axes box. For 

example, 1 is entered for a single graph. Do not select the floating 

scope check box. In the Time range box, the upper value for the time 

range is entered. For example, 1 second is entered. From the Tick 

labels list, bottom axis only is chosen. 

From the Sampling list, decimation is chosen and 1 is entered in the 

text box. 

The Scope parameters dialog box would look like such a figure 3.20 

as shown. 

 

 

 

Figure 3.20: Scope parameters Dialog Box 

 

23. One of the following done: 

 Apply is clicked to apply the changes to the model and the dialog box 

is left open. 

 OK is clicked to apply the changes to the model and the Scope 

parameters: dialog box is close. 
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24. In the Scope window, it should be pointed to the y-axis as shown in 

the Figure 3.21, and then right-clicked. 

 

25. Axes Properties is clicked from the pop-up menu. 

 

26. The Scope Properties: axis 1 dialog box is opened. In the Y-min and 

Y-max text boxes, the range for the y-axis is entered in the Scope 

window. For example, -2 and 2 are entered as shown in the Figure 

3.21. 

 

 

Figure 3.21: Scope Properties: axis 1 

 

27. One of the following is done: 

 Apply is clicked to apply the changes to the model and the dialog box 

is left open. 

 OK is clicked to apply the changes to the model and the Axes 

Parameters: dialog box is closed. 

 

The completed Simulink block diagram is shown in figure 3.22. 
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Figure 3.22: Completed Simulink Block Diagram 

 

Save As is clicked from the File menu. The Save As dialog box is opened. In 

the file name text box, a filename for the Simulink model is entered and Save 

is clicked. For example, rtwin_model is typed 

Simulink saved the model in the file , rtwin_model.mdl. 

 

 

3.7.3.2 Entering Configuration Parameters for Simulink 

 

The configuration parameters give information to Simulink for 

running a simulation. After created a Simulink model, the configuration 

parameters could be entered for Simulink. 

 

1. In the Simulink window, Configuration Parameters is clicked from 

the Simulation menu. In the Configuration Parameters dialog box, 

the Solver tab is clicked. 

 The Solver pane will open. 
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2. In the Start Time box, 0.0 is entered. In the Stop time box, the amount 

of time that model needs to run is entered. For example, 99999 

seconds is entered. 

 

3. From the Type list, Fixed-step is chosen. Real-Time Workshop does 

not support variable step solvers. 

 

4. From the Solver list, a solver is chosen. For example, the general 

purpose solver ode5 (Dormand-Prince) is chosen. 

 

5. In the Fixed step size box, a sample time is entered. For example, 

0.001 seconds is entered for a sample rate of 1000 samples/second. 

 

6. From the Tasking Mode list, singleTasking is chosen. Multitasking is 

chosen for models with blocks that have different sample times. 

 The Solver pane would look similar to the Figure 3.23. 

 

 

Figure 3.23: Configuration Parameter-Solver 
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7. One of the following is done: 

 Apply is clicked to apply the changes to the model and the dialog box 

is left open. 

 OK is clicked to apply the changes to the model and the Configuration 

Parameters dialog box is closed. 

 

3.7.3.3 Entering Simulation Parameters for Real-Time Workshop 

 

The simulation parameters are used by Real-Time Workshop for generating C 

code and building a real-time application. 

1. In the Simulink window, Configuration Parameters is clicked from 

the Simulation menu as shown in Figure 3.24. 

2. The Hardware Implementation node is clicked. 

3. From the Device type list, 32-bit Real-Time Windows Target is 

chosen. 

 

 

Figure 3.24: Configuration Parameters – Hardware Implementation 
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4. The Real-Time Workshop node is clicked. 

 The Real-Time Workshop pane will open. 

 

5. In the Target selection section, the Browse button is clicked at the 

RTW system target file list. The System Target File Browser will 

open as shown in Figure 3.25. 

 

6. The system target file is selected for the Real-Time Window Target 

and OK is clicked. 

 

 

 

Figure 3.25: System Target File Browser 

 

The system target file rtwin.tlc, the template makefile rtwin.tmf, and the 

make command make_rtw are automatically entered into the Real-Time 

Workshop pane. 

 

Although not visible in the Real-Time Workshop pane, the external 

target interface MEX file rtwinext is also configured after OK is clicked. This 

allows external mode to pass new parameters to the real-time application and 

to return signal data from the real-time application. The data is displayed in 

Scope blocks or saved with signal logging. 

The Real-Time Workshop pane would look similar to the Figure 3.26 
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Figure 3.26: Configuration Parameters – Real-Time Workshop 

 

7. After one of the following is done: 

 Apply is clicked to apply the changes to the model and the dialog box 

is left open. 

 OK is clicked to apply the changes to the model and the 

Configuration Parameters dialog box is closed. 

 

3.7.3.4 Creating a Real-Time Application 

 

Real-Time Workshop generates C code from the Simulink model, and 

then the Microsoft Visual Basic C++ compiler and links that C code into a 

real-time application. After parameters are entered into the Configuration 

Parameters dialog box for Real-Time Workshop, a real-time application 

could be built. 
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1. In the Simulink window, and from the Tools menu, it should be 

pointed to Real-Time Workshop, and then clicked Build Model. The 

build process does the following: 

 Real-Time Workshop creates the C code files  

rtwin_model.c and rtwin_model.h 

 The make utility make_rtw.exe creates the makefile rtwin_model.mk 

from the template makefile rtwin.tmf. 

 The make utility make_rtw.exe builds the real-time application 

rtwin_model.rwd using the makefile rtwin_model.mk created above. 

The file rtwin_model.rwd is binary files that refer to as the real-time 

application. The real-time application could be run with the Real-

Time Windows Target kernel. 

 

2. The Simulink model is connected to the real-time application 

After the real-time application is created, MATLAB could be closed 

and started again later, and then executable is connected and run 

without having to rebuild. 

 

3.7.3.5 Running a Real-Time Application 

 

 

 The real-time application is run to observe the behavior of the model 

in real time with the generated code. 

The process of connecting consists of 

 Establishing a connection between your Simulink model and the 

kernel to allow exchange of commands, parameters, and logged data. 

 Running the application in real time. 

 

After the real-time application is built, the model could be run in real time. 

 

1. From the Simulation menu, External is clicked, and then Connect 

To Target is connected from the Simulation menu. Also, it could be  
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connected to the target from the toolbar by clicking . It can be seen in 

figure 3.27. 

 

 

Figure 3.27: Connect to Target from the Simulation menu 

 

MATLAB will display the message 

 Model rtwin_model loaded 

 

2. In the Simulation window, and from the Simulation menu, Start Real-

Time Code is clicked. The execution also could be started from the 

toolbar by clicking . It can be seen in Figure 3.28. 
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Figure 3.28: Start Real-Time Code from Simulation menu 

 

Simulink runs the execution and plots the signal data in the Scope window. 

In the model, the Scope window displays 1000 samples in 1 second, increases 

the time offset, and then displays the samples for the next 1 second. 

Note: 

Transfer of data is less critical than calculating the signal outputs at the 

selected sample interval. Therefore, data transfer runs at lower priority in the 

remaining CPU time after real-time application computations are perform 

while waiting for another interrupt to trigger the next real-time application 

update. The result may be a loss of data points displayed in the Scope 

window. 
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3. One of the following is done: 

 The executable is let to be run until it reaches the stop time. 

 Stop Real-time Code is clicked from the Simulation menu. 

The real-time application is stopped. 

 

4. In the Simulation window, Disconnect From Target is clicked from 

the Simulation menu. 

 

5. From the Simulation menu, external is clicked 

MATLAB will display the message 

 Model rtwin_model unloaded 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

CHAPTER 4 

 

 

 

 

TEMPERATURE MEASUREMENT SOFTWARE 

 

 

 

 

4.1 Overview 

 

 

The software that use is MATLAB GUI (Graphical User Interface). 

MATLAB
® 

is a software environment for data acquisition, data analysis, and 

application development. MATLAB supports the data acquisition and 

analysis process along with interfacing with data acquisition devices and 

instruments, analyzing and visualizing the data. It also produces presentation-

quality reports to share results with others. 

 

The system that can interface with the component hardware is created. 

The program can do the evaluation of the uncertainty of temperature 

measurement. Uncertainty of measurement is the doubt that exists about the 

result of any measurement. By quantifying the possible spread of 

measurements, we can say how confident we are about the result. The 

uncertainty derives from measuring device and from the skill of the person 

doing measuring. 

 

The system also will able to plot the five point temperature 

calibrations. Calibration is the process of determining the relation between 

the output of measuring instrument and the value of the input quantity or 

attribute, a measurement standard. 
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Beside that, the system also uses to compare and measure temperature 

value and actual value and automatically calculate the output error and 

graphing for output error curve.  

 

4.2 Five Point Calibration Of Temperature Transmitter 

 

For five point calibration, the program is used to calculate the average 

value of actual UUT output. To get the average, the experiment run for 3 

times but the 1
st
 and 2

nd
 run are already set and 3

rd
 run get the data online 

from the PC. When all the reading is already set in the data, the program will 

calculate average and plot the five point temperature calibrations versus MSU 

applied value. By using the average value, output error percentage is 

calculated automatically. Then by clicking the output error button in 

MATLAB GUI, the output error curve against MSU applied value is plotted. 

Below are formula to calculate the average value and output error percentage; 

 

i) Average value = Tem 1
st
 run + Tem 2

nd
 run + Tem 3

rd
 run                     (4.1) 

    3 

ii) Output error = desired UUT output - actual UUT output   x 100%                 (4.2) 

                                             Desired UUT output 

 

4.3 Uncertainty Evaluation 

 

The uncertainty of a measurement is stated by giving a range of 

values which are likely to enclose the true value. The uncertainty of a 

measurement is found by repeating the measurement enough times to get a 

good estimate of the standard deviation of the values. Then, any single value 

has an uncertainty equal to the standard deviation. However, if the values are 

averaged, then the mean measurement value has a much smaller uncertainty, 

equal to the standard error of the mean, which is the standard deviation 

divided by the square root of the number of measurements. 
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Standard deviation can be calculated by using the formula; 

 

Std deviation = sqrt(sum((value - mean) ² ) / N) or  

  ℴ = √∑ (𝑥𝑖 − 𝑥̅𝑛
𝑖−1 )²                                                                    (4.3) 

Mean = sum (value) / N or 𝑥 ̅ =
1

𝑁
∑ 𝑥𝑖𝑁

𝑖−1  

 

i. Uncertainty Due to Repeatability of The Experiment 

For determining the uncertainty contribution due to repeatability 

experiment, the worst case standard deviation is chosen. The 

uncertainty is equal with the experimental standard deviation of mean 

s (𝑥̅). This s (𝑥̅) is the estimation of the spread of the distribution of 

the means. For a sample size n=3 the formula for the standard 

deviation of the mean is given by; 

S(𝑥̅)= 𝑆( 𝑋𝑘)÷ √𝑛                                                                               (4.4) 

       = 𝑆( 𝑋𝑘) ÷ √3 

Thus, uncertainty, U1 equal to S (𝑥̅) with a degree of freedom y1 = 3-1=2. 

 

ii. Uncertainty Contribution Due to MSU Error 

The MSU used in this calibration is the Model: MT220, digital 

manometer standard. For the 700 kPa range, the accuracy 

specification for this instrument provided by the manufacturer is the 

following: 

±(0.01% + 0.005% range) 

For a maximum reading of 200 kPa and range of 700kPa. Hence the error in 

MSU = ±((0.0001 x 200) + (0.00005 x 700) V. Therefore the maximum error,  

a = 0.035 kPa. 

The uncertainty contribution due to MSU error, U2 is given by; 

U2 = a/√3 = 0.035/√3 = 0.020207 kPa with a degree of freedom y2 =  
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iii. Uncertainty Due to UUT Resolution / MSU resolution. 



 

Considering the worst case scenario the maximum resolution is 0.06 

kPa. The uncertainty U3 is calculated as; 

U3= 0.06√3 =0.034641 kPa with y3=  

 

iv. Combined Standard Uncertainty, Uc 

The combination standard uncertainty, Uc is determined from the 

individual uncertainties U1, U2, U3, by the following formula; 

𝑈𝑐 = √𝑈1² + 𝑈2² + 𝑈3²                                                               (4.5) 

                  

The effective degrees of freedom, Ve is given by; 

𝑉𝑒 =
(𝑈𝑐²)²

(𝑈12)²

𝑉1

                                                                                (4.6) 

The total uncertainty, U at any confidence level is determined using 

student’s t distribution. The coverage factor K is determined from the 

student table. 

The confidence limits are obtain by formula, 

U=Uc×K                                                                                         (4.7) 

 

 

4.4 Procedures to Run MATLAB GUI for Plotting Graph 

 

i) The first step to open the MATLAB GUI is to type ‘guide’ in the 

MATLAB command window as shown in figure 4.1 

. 

 

Figure 4.1: Command window (guide) 
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ii) Choose to open the sample GUI by clicking on “Open Existing GUI”. 

Click on “Browse” to locate where you saved the GUI files.(Figure 

4.2) 

 

 

 

Figure 4.2: Guide Quick Start 

 

iii) To execute the GUI, open the file for five point Calibration of 

Temperature Transmitter. The figure below will appear. (Figure 4.3) 
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Figure 4.3: GUI for Plot Graph 

 

iv) Then click the green button  at the top of GUI design to run the 

program. (Figure 4.4) 
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Figure 4.4 Plot Graph GUI 

 

v) There is Guide for a new user about the procedures or step that needs 

to know to use the system. Click the   button to read the 

procedures before starting. The dialog box would look similar to the 

figure 4.5. 
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Figure 4.5: Procedures to Use Program 

 

vi) After run the GUI, click  button to get the data from SIMULINK. 

The value of actual UUT output that taken from experiment will 

display at the edit text.(Figure 4.6) 
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Figure 4.6: Simulate Button 

 

vii) The reading that simulate from DAQ is in voltage, so click the 

 button to change the reading to current. 

 

viii) After finished simulate the actual value, click the  button 

to get the value for the average value that calculated automatically by 

the program. Follow by clicking the button to get the 

value for the output error that calculated automatically by the program 

(Figure 4.7) 

 

 

 

 

 

 

 

 

                                                                                                                                     53 

 



 

 

Figure 4.7: Average Button 

 

ix) Next, click button to get the graph of five point calibration 

of temperature transmitter vs. MSU applied Value.(Figure 4.8) 

 

 

Figure 4.8: Plot axes 1 Button 

 

x) After the graph appear, click  button to save the graph. The 

dialog box will look similar to the figure 4.9. Change the file name 

and save as bitmap (*.bmp) then save at any folder by click “save”. 
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Figure 4.9: Save Picture as 

xi) Next, click the button to get the graph of output error curve 

against MSU     applied value. (figure 4.10) 

 

 

Figure 4.10 Plot axes 2 Button 

 

xii) Then save the graph by clicking . The step to save is similar 

with step (viii). 

 

xiii) If the users want to repeat back the experiment, click the 

button. This will reset or clear all the data and graph. 

 

xiv) If the user wants to leave the system, click , the dialog box 

as figure 4.11 will appear. Click ‘YES’ to close. But if the user wants 

to continue with the uncertainty evaluation, click 

 at the bottom of the GUI. 
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Figure 4.11: Close Request Function 

 

4.5 Procedures to Run MATLAB GUI for Uncertainty 

 

i) To run the GUI for uncertainty evaluation clicked 

the button  at the buttom of the figure 4.12 

to open the separate gui file. This allowed the user sharing data 

between to separate GUI.  

 

 

 

Figure 4.12 Uncertainty Evaluation Button 
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ii) Figure as below appeared (refer Figure 4.13).  

 

 

 

Figure 4.13: Uncertainty Evaluation GUI 

 

iii) Click  to capture data from the Plot Graph GUI. Data for 

MSU reading will automatically transfer to this GUI. This is use 

application of sharing data between two separate GUIs. After finished 

capturing data, click the  Then click  

(Figure 4.14). 

 

 

Figure 4.14: Average and Standard Deviation Button 
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iv) Then choose the lowest case standard deviation by clicking the  

button. (Figure 4.15) 

 

 

 

Figure 4.15: Lowest Standard Deviation 

 

v) Then user can see  the value that have select will  appear  at the empty 

white button as in figure below. (Figure 4.16) 

 

 

 

Figure 4.16: Lowest standard Deviation 
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vi) Now, click the  button to get the value of Uncertainty 

Due to Repeatability of The Experiment (u1), U2 (Uncertainty 

Contribution Due to MSU Error), U3 (Uncertainty Due to UUT 

Resolution / MSU resolution), Uc (Combined Standard Uncertainty) 

and Ve (The effective degrees of freedom). (Figure 4.17) 

 

 

 

Figure 4.17: Calculate Button 

 

vii) The total uncertainty at any confidence level is determined using t-

Distribution table. Thus to choose the value of K, user must choose 

the value that lower than Ve value (k< Ve). For Ve than greater than 

100, choose K for v=100.User can choose by click any K value that 

suitable at t-Distribution table. Then it will appear as below. (Figure 

4.18) 
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Figure 4.18: T-Distribution Button 

 

viii) Lastly, click button to get total uncertainty. (Figure 4.19) 

 

 

 

Figure 4.19: Total uncertainty 
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ix) After complete all of the calculation, user can save the result in 

EXCEL .click  button and MATLAB GUI will link to excel. 

Excel booklet will appear as in Figure 4.20. This will allow user to 

key in all the data.  

 

 

 

Figure 4.20: Excel Link 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

CHAPTER 5 

 

 

 

 

RESULT AND ANALYSIS 

 

 

 

 

5.1 Result  For Five – Point Calibration Of Temperature 

Transmitter 

 

Table 5.1 shows the average of actual UUT output and output error 

from the manual calculation.  As the reading of 1
st
 run and 2

nd
 run is fixed, 

that mean the value of average and output error was depend on 3rd run 

reading. As the actual UUT outputs reading get closer to the desired UUT 

output, the output error decreased. 

 

Table 5.1: Five – Point Calibration of Temperature Transmitter 

 

 

 

 

 

 

 

 

5.2 C

a

l

c

u 

 

 

 

N0 

% 

MSU 

applie

d 

Value 

(°C) 

Desire

d 

UUT 

output 

(mA) 

Actual UUT output (mA) 

 

 

Output 

error 

(%) 

1
st
 run 2

nd
 run 3

rd
 run average 

0 50      4  3.889  3.798  3.996  3.894  2.6500 

25     87.5      8  7.998  7.999  7.994  7.997  0.0375 

50     125     12 12.000  11.999  11.997 11.998  0.0167 

75    

162.5 

    16 15.999 15.999 15.998 15.999  0.0313 

100     100     20 19.995 19.876 19.857 19.909  0.4550 
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5.2 Calculation For Five – Point Calibration Of Temperature 

Transmitter 

 

i. The desired output for 4-20 mA range is calculated based on the 

50-100°C range using below equation: 

𝐷𝑒𝑠𝑖𝑟𝑒𝑑 𝑜𝑢𝑝𝑢𝑡 =
𝑥

100 
(𝑈𝑅𝑉 − 𝐿𝑅𝑉) + 𝐿𝑅𝑉 

Where;   X= ith point 

URV= Upper range value 

LRV= Lower range value 

 

Thus; 

For 𝑥 = 0, 

Desire output = x/100(URV – LRV) + LRV 

                        = 0/100(20mA – 4mA) + 4mA 

                        = 4mA 

For 𝑥 = 25; 

Desire output = 𝑥 /100(URV – LRV) + LRV 

                        = 25/100(20mA – 4mA) + 4mA 

                        = 8mA 

 

For 𝑥 = 50 

Desire output = 𝑥 /100(URV – LRV) + LRV 

                        = 50/100(20mA – 4mA) + 4mA 

                        = 12mA 

 

For 𝑥 = 75 

Desire output = 𝑥 /100(URV – LRV) + LRV 

                        =75/100(20mA – 4mA) + 4mA 

                        = 16mA 
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For 𝑥 = 100 

Desire output = 𝑥 /100(URV – LRV) + LRV 

                        =100/100(20mA – 4mA) + 4mA 

                        = 20mA 

 

ii. The average actual UTT output can calculated based on the equation 

below; 

 

Average value = tem 1
st
 run + tem 2

nd
 run + temp 3

rd
 run 

3 

For 𝑥 = 0; 

Average value = 3.889+ 3.798+ 3.996 

         3 

             = 3.894 mA 

 

For 𝑥 = 25; 

Average value = 7.998+ 7.999+ 7.997 

     3 

              = 7.997 mA 

 

For 𝑥 = 50; 

Average value = 12.000+ 11.998+ 11.997 

     3 

                                   = 11.998 mA 

 

For 𝑥 = 75; 

Average value = 15.999+ 15.999+ 15.998 

     3 

= 15.999 mA 
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For 𝑥 = 100; 

Average value = 19.995+ 19.876+ 19.857 

     3 

                                    = 19.909 mA 

 

iii. The output error can calculated based on the equation below: 

 

 Output Error = desired UUT output - average UUT output   x 100% 

                                                                            Desired UUT output 

 

Thus for 50°C; 

Output Error = (4-3.894)/√4  100% 

                        = 2.65% 

 

  For 87.5°C; 

  Output Error = (8 - 7.995)  100% 

                                       =0.0625% 

 

For 125.0°C; 

Output Error = (12 - 11.998)/  100% 

                       =0.0167% 

 

For 162.5°C; 

Output Error = (16-15.995)/  100% 

                                     = 0.0313%          

 

For 200.0°C; 

Output Error = (20-19.909)/  100% 

                                     =0.455% 
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5.3 Result using Software 

 

5.31 The average actual UTT output can show below. (Figure 5.1) 

 

 

 

Figure 5.1: Average actual UUT Output 

 

 

5.3.2 The graph for five point calibration of temperature against MSU applied 

value from GUI. 

  

Figure 5.2 shown the graph for five point calibration of temperature 

transmitter or average output versus MSU applied Value. Average output is 

proportionally with MSU applied value. As the MSU value is constant, when 

MSU applied value increase the value of average output also increased. 
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Figure 5.2: Graph for Five Point Calibration of Temperature Transmitter 

 

 

5.3.3 The output error calculated using GUI (Figure 5.3) 

 

 

 

Figure 5.3: Output Error 
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5.3.4 The graph for output error curve against MSU applied value from GUI  

 

Figure 5.4 shows the graph for output error versus MSU applied value. The 

shape of the graph is curved because the output error is depending on the reading 

from the experiment. Less error of the reading means more precision the experiment. 

 

 

 

                                    Figure 5.4: Graph Output Error Versus MSU applied Value 

 

 

5.4  Comparison between manual calculation and by using software  

 

 Table 5.2 shown the comparison between manual calculation and 

calculation using the system that have been developed. The value of actual 

and output error from the manual calculation is almost same with the 

calculation using system. So that, it proved that the system are done the 

correct calculation. 

 

Table 5.2: Comparison between manual and Software 
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5.5 Result  For Uncertainty Evaluation  

 

Table 5.3 shows the result for uncertainty from the manual 

calculation. Using average output, standard deviation is calculated for each 

run. The highest value of standard deviation will use to calculate the 

uncertainty. Refer to the Table 5.3; the highest value of standard deviation is 

1.3890 . 

 Table 5.3: uncertainty due to repeatability of the experiment 

 

 

 

 

5.6 C

a

l

c

u

l 
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No 

                    Manual                     software 

Actual UUT 

output average( 

mA) 

Output Error 

(%) 

Actual UUT 

output 

average 

( mA) 

Output 

Error 

(%) 

      1             3.894 2.65 3.89433 2.64167 

      2             7.997 0.0375 7.997 0.045833 

      3             11.998 0.0167 11.9983 0.013889 

      4             15.999 0.0313  15.9983 0.033333 

      5             19.909 0.4550 19.9093 0.4550 

No Desired 

UUT 

output 

(mA) 

Actual UUT output (mA) 

 

 

Standard  

deviation 

1
st
 run 2

nd
 run 3

rd
 run average 

    1      4  3.889  3.798  3.996  3.894  1.3890e-2 

    2      8  7.995  7.997  7.994  7.995  3.5355e-6 

    3     12 12.000  11.998  11.997 11.998  3.5355e-6 

    4     16 15.989 15.997 15.999 15.995 3.9598e-5 

    5     20 19.995 19.876 19.857 19.909 6.7663e-3 



 

 

5.6 Calculation for Uncertainty Evaluation 

 

i. Calculation for standard deviation Refer to equation (4.3) 

 

For desired UUT = 4mA; 

S ( ) =   (3.889-3.894)² + (3.798-3.895)² + (3.996-3.895)²] 

                 =0.01389 =1.3890e-2 

 

For desired UUT = 8mA; 

S ( ) =   [(7.995- 7.997)² + (7.998-7.995)² + (7.994-7.995)²] 

                 =3.5355e-6 

 

For desired UUT = 12mA; 

S ( ) =   [(12.00-11.998)² + (11.998-11.998)² + (11.997-11.998)²] 

                 =3.5355e-6 

 

For desired UUT = 16mA; 

S ( ) =   [(15.989-15.995)² + (15.997-15.995)² + (15.999-15.995)²] 

                 =3.9598e-5 

 

For desired UUT = 20mA; 

S ( ) =   [(19.995-19.909)² + (19.876-19.909)² + (19.857-19.909)²] 

                   =6.7663e-3 

 

 

ii. Uncertainty Due to Repeatability of The Experiment 

 

Choose the lowest standard deviation  or the highest value of standard 

deviation. 

From the table the, choose 1.3890e-2 as lowest case. (Refer to equation (4.4)). 
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Where S ( ) = )                                

                                  =  

                           = 0.01389  

                           = 8.0194  

Thus, uncertainty, U1 equal to S ( ) =8.0194e-3 kPa with a degree of 

freedom y1 = 3-1=2. 

 

 

iii. Uncertainty Contribution Due to MSU Error 

U2 = a/ = 0.035/ = 0.020207 kPa with a degree of freedom y2 = 

 

 

iv. Uncertainty Due to UUT Resolution / MSU resolution. 

U3= 0.06 =0.034641 kPa with y3=  

 

v. Combined Standard Uncertainty, Uc 

When U1=8.0194e-3 kPa, U2= 0.020207 kPa, U3= 0.034641 kPa. 

Refer to equation (4.5). 

                                   

                             = 0.040898 kPa 

 

The effective degrees of freedom, Ve is given by; 

                   

                   

                         

The confidence limits are obtain by formula, 

                                       U = Uc  K   

Referring to the Table of student’s t distribution. #(note: for the Ve 

than greater than 100,  use v=100) 
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Let k = 2.025 

 Thus;   U = Uc  K                 

                      = 0.040898 2.025 

                      = 0.08281 kPa 

 

5.7 Result using Software for uncertainty evaluation 

 

5.7.1 The average of MSU reading and standard deviation using GUI is 

as below. (Figure 5.5) 

 

Figure 5.5 shows the value of standard deviation that calculated using 

the system. The value are 0.138909, 3.29983 , 3.29983 , 

3.9598 , and 0.00711 which almost same with manual calculation. It 

was proved the system is calculated the value correctly. 

 

 

 

Figure 5.5: Result for Average and Standard Deviation 
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5.7.2  Uncertainty Due to Repeatability of The Experiment (U1), 

Uncertainty Contribution Due to MSU Error (U2), Uncertainty Due to UUT 

Resolution / MSU resolution (U3), Combined Standard Uncertainty (Uc) and 

The effective degrees of freedom (Ve) (Figure 5.6) 

 

 

 

Figure 5.6 U1, U2, U3, Uc, and Ve value 

 

5.7.3      The Total Uncertainty (U) calculated using GUI (figure 5.7) 

 

The total uncertainty is the reading that represented the doubt that exists 

about the result of any measurement. Therefore 0.0828184 is the uncertainty of this 

system. So, lower value of uncertainty more precise the reading. Figure 5.7 shows 

the total uncertainty using the system. 
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Figure 5.7 Total uncertainty 

 

5.8 Costing and Commercialization 

 

This project do not have any cost because it more to the system development 

using software. All the instruments and DAQ card is provided at Lab. As this system 

is use for the learning process for Industrial Instrumentation subject, so it not suit to 

commercialize.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

CHAPTER 6 

 

 

 

 

CONCLUSION AND RECOMMENDATION 
 

 

 

6.1 Conclusion 

 

The objectives of the project are successfully achieved. After finished 

this project, the basic of temperature instrumentation were able to be 

understand such as the theory of temperature measurement, thermocouple 

connection and skills of handle experimental instruments. 

 

Then, the PCI 1710HG is used to integrate the instrument and 

software for user easily interfaces with the system. The basic operation of 

DAQ card is also has been studied included DAQ configuration using real 

time window target. Beside that SIMULINK model are also studied for 

running DAQ and transferring data to MATLAB WORKSPACE. Method for 

displayed data to MATLAB GUI from WORKSPACE also has been success 

implemented to the system. 

 

The system was able to calculate the average and output error of 

actual reading, plot five point calibration and error curve. Besides, 

uncertainty evaluation also developed. This system can be implementing in 

Industrial Instrumentation class.  
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6.2 Recommendation 

 

There are some future research to be considered in improving and 

searching for the details of this project. First is by using Excel link. Although, 

excel link was success implemented in the system but the user still need to 

key in the data manually. Therefore in the future this system can be improved 

by implement excel link that can automatically save all the graph and result 

of all calculation so that user no need to key in it manually. This excel link 

would make user easily do their lab report. 

 

Besides that, to make the user easily simulate the data using DAQ, in 

future use one pushbutton and program it to be able to capture data for each 

temperature that required automatically. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                                             76 



 

 

 

 

REFERENCES 

 

 

[1] US Department of energy office of fossil energy, national energy  Technology 

laboratory 

 

[2]  http://en.wikipedia.org/wiki/MATLAB 

 

[3]  Dr Recayi Pecen, Dr. MD Salim, & Mr. Ayhan Zora, A LabView Based 

Instrumentation System for a Wind-Solar Hybrid Power Station, Journal of 

Industrial Technology, June 2004 through August 2004, Volume 20, Number 

 

[4] Scott T. Smith, MATLAB Advanced GUI Development, http://www.mat-

gui.com 

 

[5] V. Gyurjyan, C. Timmer, D. Abbott, G. Heyes, E. Jastrzembski, D. Lawrence, 

E. Wolin, Jeferson LAB DATA acquisition run control system, TJNAF, 

Newport News, VA 23606, USA 

[6] Bernard Morris, Vice-President of Sales, Hart Scientific, Inc, Temperature 

Calibration in Industrial Processes 

[7] Stanley Wolf and Richard F.M Smith, student reference Manual for 

Electronic Instrumentation Laboratories, 2
nd

 Ed, Pearson Prentice Hall, 2004. 

[8] Bartelt, Industrial Control Electronics devices, System & Application, 2nd 

Ed, Thomson Learning, 2002. 

 

[9]http://www.yokogawa.com/fld/TEMPERATURE/fld-temperature-01en.htm 

 

 

 

 

 

                                                                                                                         77 

http://en.wikipedia.org/wiki/MATLAB
http://www.mat-gui.com/
http://www.mat-gui.com/
http://www.yokogawa.com/fld/TEMPERATURE/fld-temperature-01en.htm


 

 

[10] http://www.ueidaq.com/daq.html 

 

[11]  Gerson  Beauchamp-baez, Luis V. Melendez-Gonzalez. Department of   

Electrical and Computer Engineering. University of Puerto Rico – Mayaguez 

Campus 

Available at: fie.engrng.pitt.edu/fie98/papers/1226.pdf 

 

[12] http://zone.ni.com/devzone/cda/tut/p/id/4084 

 

[13] US Department of energy office of fossil energy, national energy 

Technology laboratory 

 

[14] Fred Schraff, P.E., IOtech, Inc.  The Principles and Methods of Using 

Thermocouples 

Available at: http://www.iotech.com/mcjun96.html 

 

[15] http://edis.ifas.ufl.edu/AE077 

 

[16] http://en.wikipedia.org/wiki/MATLAB 

 

[17] Tom Green and M.E Parten, PC-based Medical Data Acquisition and 

Analysis, Texas Tech University. 

 

[18] http:// www.blinkdagger.com 

 

 

 

 

 

 

 

 

 

                                                                                                             78 

http://www.ueidaq.com/daq.html
http://zone.ni.com/devzone/cda/tut/p/id/4084
http://www.iotech.com/mcjun96.html
http://edis.ifas.ufl.edu/AE077
http://en.wikipedia.org/wiki/MATLAB
http://www.blinkdagger.com/


 

 

APPENDIX A 

 

Choice of Master Standard Units 

 

 
 

 

 

 

 

 

 

                                                                                                                                   79 



 

 

 
 

 

 

 

 

 

 

 

 

 

 

                                                                                                                                   80 



 

 

APPENDIX B 

 
Thermocouple Reference 

 
 

 

                                                                                                          81 



 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                                           82 



 

 

 

APPENDIX C 

 

T- Distribution Table 
 

 
 

 

 

 

 

 

 

 

 



 

 

 

 

 

APPENDIX D 

 

PCI-1710HG DATA SHEET 

 


